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Overview 

Stellar MBOX to PST Converter converts mailbox from Thunderbird, Spicebird, Entourage, Pocomail, 

Eudora, AppleMail, Mulberry, SeaMonkey, Netscape, ClawsMail, OperaMail, MozillaMail, Evolution, 

Sylpheed, Cone, Mutt, and Gnu Mail files to Outlook mailbox (PST files). You can see the preview of 

converted mails after successful completion of conversion process. 

 

The software gives option to save the converted mails to a new or existing Outlook PST file. 

 

What's New in this version? 

 

 Support for MS Outlook 2016. 

Key Features of Stellar MBOX to PST Converter 

 User friendly and secure software. 

 Converts Thunderbird files to Outlook PST files. 

 Converts Cone to Outlook PST files. 

 Converts Mutt files to Outlook PST files. 

 Converts Gnu Mail files to Outlook PST files. 

 Converts Spicebird files to Outlook PST files. 

 Converts Entourage files to Outlook PST files. 

 Converts Pocomail files to Outlook PST files. 

 Converts Eudora files to Outlook PST files. 

 Converts AppleMail files to Outlook PST files. 

 Converts Mulberry files to Outlook PST files. 

 Converts SeaMonkey files to Outlook PST files. 

 Converts Netscape files to Outlook PST files. 

 Converts ClawsMail files to Outlook PST files. 

 Converts OperaMail files to Outlook PST files. 

 Converts MozillaMail files to Outlook PST files. 

 Converts Evolution files to Outlook PST files. 



 Converts Sylpheed files to Outlook PST files. 

 Provides preview of mails. 

 Log Report. 

  



Installation Procedure 

Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements 

 Processor: Pentium Class 

 Operating System: Windows 10 / Windows 8.1 / Windows 8 /  Windows 7 / Windows Vista / 

Windows  Server 2008 / Windows Server 2003  

 Microsoft Office: 2016, 2013, 2010, 2007, 2003 

 Memory: Minimum 1 GB 

 Hard Disk: 50 MB of Free Space 

To install the software, follow these steps: 

 Double-click StellarMBOXtoPSTConverter.exe executable file to start installation. Setup - 

Stellar MBOX to PST Converter dialog box is displayed.  

 Click Next. License Agreement dialog box is displayed. 

 Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

 Click Browse to select the destination path where the setup files will be stored. Click Next. 

Select Start Menu Folder dialog box is displayed. 

 Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks 

dialog box is displayed. 

 Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.  

 Review the entries. Click Back if you want to change them. Click Install to start installation. The 

Installing window shows the installation process. 

 After completing the process, Completing the Stellar MBOX to PST Converter Setup Wizard 

window is displayed. Click Finish. 

 

Note: Clear Launch Stellar MBOX to PST Converter check box before clicking Finish to prevent the 

software from launching. 

  



Launching the Software 

To launch Stellar MBOX to PST Converter in Windows 10: 

 Click Start icon -> All apps -> Stellar MBOX to PST Converter  -> Stellar MBOX to PST 

Converter  Or, 

 Double click Stellar MBOX to PST Converter icon on the desktop. Or, 

 Click Stellar MBOX to PST Converter tile on the home screen. 

To launch Stellar MBOX to PST Converter in Windows  8.1 / 8: 

 Click Stellar MBOX to PST Converter tile on the home screen. Or, 

 Double click Stellar MBOX to PST Converter icon on the desktop. 

To launch Stellar MBOX to PST Converter in Windows 7 / Vista: 

 Click Start -> Programs -> Stellar MBOX to PST Converter -> Stellar MBOX to PST Converter. 

Or, 

 Double click Stellar MBOX to PST Converter icon on the desktop. Or, 

 Click Stellar MBOX to PST Converter icon in Quick Launch. 

  



User Interface 

Stellar MBOX to PST Converter software has a very easy to use Graphical User Interface. The user 

interface contains features required for conversion. 

 

After launching the program, you will see the main user interface as shown below: 

 

 

 

The user interface contains menus and buttons that lets you access various features of the software with 

ease.  

  



Menus 

File 

Select Mail Client 
Use this option to open Select Mail Client to be 
Converted to Outlook PST dialog box. 
 
Save Converted Mailbox 
Use this option to start the conversion process. 
 
Exit 
Use this option to exit the application. 

 

 

File Menu 

View 

Log Report 

Use this option to view and save log report 

 

 

View Menu 

Registration 

Register Stellar MBOX to PST 

Converter 

Use this option to register the 

product. 

 

Transfer License 

Use this option to transfer the 

license of the registered software to 

another computer. 

 

 

Registration Menu 

 

Help 

 



 

Stellar MBOX to PST 

Converter Help 

Use this option to see user 

help guide. 

 

Purchase Stellar MBOX to 

PST Converter 

Use this option to buy Stellar 

MBOX to PST Converter. 

 

View Support Section 

Use this option to visit 

support page of 

stellarinfo.com. 

 

Visit Knowledge Base  

Use this option to visit 

knowledgebase articles of 

stellarinfo.com. 

 

Submit Enquiry 

Use this option to submit 

enquiry to stellarinfo.com. 

   

About Stellar MBOX to PST 

Converter 

Use this option to read 

information about the 

software 

. 

  

 

Help Menu 
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Buttons 

 

 

Select Mail Client  

 

 

 
Click this button to open Select Mail Client to be Converted to Outlook 
PST dialog box. 

 

 

Convert to PST  

 

 

 

Click this button to start the conversion process.   

 

 

Help 

 

 

 

Click this button to access the User Guide.  

 

 

Update Wizard  

 

 

 

Click this button to check for both, latest minor and major version available 

online.  

 

 

Purchase 

 

 

 

Click this button to purchase the software.  

 

 

About 

 

 

 

Click this button to know about the software.  

  



Ordering the Software 

Click https://www.stellarinfo.com/email-tools/mbox-to-pst-converter.php to know more about Stellar 

MBOX to PST Converter. 

To purchase the software online, please visit https://www.stellarinfo.com/email-tools/mbox-to-pst-

converter/buy-now.php 

Alternatively, click Purchase button on the application tool bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 

to register the software. 
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Registering the Software 

The demo version is just for evaluation purpose and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Registration Key which you will 

receive via email after purchasing the software.  

To register the software: 

1. Run demo version of Stellar MBOX to PST Converter software. 

2. On Registration menu, click Register option. Register window is displayed as shown below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the product) 

or select ’I have the registration key’ (Use this option if you have already purchased the product). 

 

To register the software, when you do not have a registration key, follow the steps given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online 

and purchase the product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of 

purchase.  

3. In the Online Registration window, type the Registration Key and click Register button (Please 

ensure that you have an active Internet connection). 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

 

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) 

or 'Offline Registration' (Use this option to register the software manually / through e-mail if for 

any reason, Internet connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK.  

 

2. An Online Registration dialog box will appear. 



3. Type the Registration Key (received through email after purchasing the product) in the 

field of Registration Key. Click Register. 

 

4. The software would automatically communicate with the license server to verify the 

entered key. If the key you entered is valid, software will be registered successfully. 

 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an Internet 

connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK.  

 

2. An Offline Registration dialog box will appear displaying Registration ID in its 

respective field. 



 

3. To get your License Key, which is required to register the software manually, you need to 

mail the listed Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open Stellar MBOX to PST Converter. In Register 

window, select 'I have the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key 

is entered. Click OK. 
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Transfer License 

Stellar MBOX to PST Converter allows you to transfer the license of the registered software to another 

computer on which you want to run the software with full functionality. This operation deactivates the 

product on your current computer so it can be reactivated on the new computer.  

To transfer a software license from one computer to another, please follow the specific steps 
below: 

On Target Computer:  

1. Run demo version of the software. 

2. In Registration Menu on Menu Bar, click Register. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK.   

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field. 

 

 

On Source Computer: 

1. Run registered version of Stellar MBOX to PST Converter software. 

2. In Registration Menu on Menu Bar, click Transfer License. 



 

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the 

Source Computer. 

4. To get your License Key, click Transfer In button on Source Computer. This will generate a 

License Key. 

 

5. You can also save the License Key generated on the source computer. Click Save to File button 

to save the Registration ID and the License Key. In Browse for Folder dialog box, select the 

location where you want to save the details. Click OK. 

6. ' License Key has been saved successfully ' message is displayed after the saving process is 

completed successfully. Click OK. 

This will deactivate the product on Source Computer and you will no longer be able to use the software 

anymore on this computer. 

 

On Target Computer: 

1. Type the License Key which you have generated on the Source Computer in the provided field of 

License Key. 



 

2. Click Register to complete the activation process.  

3. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK. 

  



Updating the Software 

There are periodical software updates for Stellar MBOX to PST Converter. The software updates should 

be done to keep the software up-to-date. The updates can be a newly added functionality, a new feature, 

a new service, or any other information that can be important for improvement. Update option in the 

application is capable of checking for the latest updates. This will check for both latest minor and major 

version available online. You can easily download minor version through the update wizard. However, the 

major version, if available, has to be purchased. While updating the software, it’s recommended to close 

all the running programs. Note that demo version can not be updated.  

To update the application, follow these steps: 

 Click on Update Wizard button in application tool bar. Update Wizard is displayed. 

 Click Next. A busy timer shows that updates are being searched. If any new version is found, a 

message indicates its availability.  

 If a message is displayed that no updates are available, Click Cancel to close the wizard. 

 Click Next. The software will start downloading the update files from the server. When the 

process is complete, the software will upgrade to the latest version.  

  



Uninstalling the Software 

You can use any of the following options to uninstall Stellar MBOX to PST converter:  

 Click Start -> All Programs -> Stellar MBOX to PST Converter -> Uninstall Stellar 

MBOX to PST Converter. Follow on screen instructions to completely remove the 

software, including registry entries from your computer. Or, 

 

 Click Start -> Control Panel -> Add or Remove Program. Select Stellar MBOX to PST 

Converter entry from the displayed list and click Change/Remove. Follow on screen 

instructions to completely remove the software as well as registry entries from your 

computer. 

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products.  

You can either call us or go online to our support section at http://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/email-tools/mbox-to-pst-

converter/buy-now.php 

Chat Live with an Online technician at http://www.stellarinfo.com 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com. 

 

 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

 

USA (Tollfree- Pre Sales Queries) 

 

+1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales 

Support 
+31-208-111-188 

Worldwide +91-124-4326-777 

Email Orders  

 

  orders@stellarinfo.com 
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Select File(s)/Identity 

To select MBOX file / Identity: 

 Launch Stellar MBOX to PST Converter. Select Mail Client to be Converted to Outlook PST 

dialog box is displayed as shown below: 

 

 

 

 Click on the desired Mail Client icon. 

  Select File/Folder dialog box opens as shown below:  

 

 

 

 Click Select File/Select Identity Folder button and locate file/Identity. 

 Selected file/Identity path is displayed in Select File/Folder Path text box. 

 Click Convert button to start the conversion process. 

 



Note: You can only select a complete Identity folder for the following mail clients: Apple Mail, ClawsMail, 

MozillaMail, OperaMail, Sylpheed.  

  



Find Files 

You can search for MBOX, MBX, MacMBOX, and AppleMail files using Find File Option in Select 

File/Folder dialog box. You can search for files in drives, folders and sub folders. However, you can select 

only one drive at a time to search for files. 

To search for MBOX, MBX, MacMBOX, and AppleMail files: 

 Click Find File Option in Select File/Folder dialog box. 

 Browse for Folder dialog box opens. 

 Select the required drive/folder/sub folder and click OK to search for files.  

 After the search is finished, list of MBOX/MBX/MacMBOX/AppleMail files found in the selected 

drive/folder/sub folder is shown in Select files dialog box as shown below: 

 

 

 

 Select file(s) you wish to convert from this list and then click Convert to start the conversion process. 

  



Preview of Mails 

You can see the preview of converted mails after successful completion of conversion process. Left pane 

displays selected MBOX filename under Root node in a tree like structure. Upper right pane displays the 

list of converted mails. To see content of desired mail, click on it in upper right pane. The content is 

displayed in lower right pane as shown below. 

 

 

  



Save Converted Mails 

To save converted mails: 

 Click Convert to PST button on the toolbar or select Convert to PST option in the File menu. 

 Save File dialog box opens as shown below. 

 

 

 

 To save converted mails into a new PST file: 

 Select Save as new Outlook PST File and click Browse.  

 Browse For Folder dialog box opens. Select location for saving PST file and click 

OK. 

 The converted mails will be saved into a new PST file at the specified location. 

 

 To save converted mails into an existing PST file: 

 Select Append data into existing profile/PST file. Select Profile and PST dialog 

box appears as shown below: 

 



 

 

 To add the converted mails to an existing Outlook profile, choose Select Outlook 

Profile to add converted mails and select one of the profiles that appear in the 

list. Click OK. 

Or,  

To add the converted mails to an existing Outlook PST file, choose Select Outlook 

PST file to add converted mails and then click Browse to select the PST File. Click 

OK.  

 The converted mails will be saved into the selected Outlook Profile / Outlook PST 

file. 

  



Import PST files in MS Outlook 

To import PST file in Microsoft Outlook 2016 / 2013: 

 Open Microsoft Outlook. From File Menu, select Open & Export.  

 Select Import / Export option from the right pane. 

 From Import and Export Wizard window, select Import from another program or file, click 

Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next.  

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

To import PST files in Microsoft Outlook 2010:  

 Open Microsoft Outlook. In the File Menu, select Open -> Import. 

 In the Import and Export Wizard, select Import from another program or file, click Next. 

 In the Import a File dialog box, select Outlook Data File (.pst), click Next.  

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In the Import Outlook Data File dialog box, select the folders that should be imported in 

Microsoft Outlook. Click Finish. 

To import PST files in Microsoft Outlook 2007 / 2003: 

 Open Microsoft Outlook. In the File menu, select Import and Export. 

 In the Import and Export Wizard, select Import from another program or file, click Next. 

 In the Import a File dialog box, select Personal Folder File (PST), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

 In the Import Personal Folders dialog box, select the folders that should be imported in 

Microsoft Outlook. Click Finish.  

 

  



View and save Log Report  

During and after completion of the conversion process, you can see log details in bottom window of 

Stellar MBOX to PST Converter. The Log Report window displays beginning of the process, end of the 

process, name of the file etc. during running of the process. With Stellar MBOX to PST Converter, you 

can save Log Report to analyze recovery process at a later stage. 

   
 To view log details, click Log Report in View menu on the menu bar. Log Report window opens 

as given below. 

 

 

 

 Click Save Log button to save log report. Enter file name and choose destination in Save As 

dialog box.  

 

 Click Clear Log button to clear Log Report. 

 

 Click Close button to close Log Report. 

  



FAQs 

1. What does the demo version of the software do? 

In demo version of the software, you will be able to see the mail body but cannot open 

attachments. To view / save all data and open attachments, you need to purchase and register the 

software. 

 

2. What is MBOX file format? 

The MBOX file is the most common format for storing email messages on a hard drive. All the 

messages for each mailbox are stored as a single, long, text file in a string of concatenated e-mail 

messages, starting with the From header of the message. 

   
An MBOX is a text file containing an arbitrary number of e-mail messages. Each message consists 

of a postmark, followed by an e-mail message formatted according to RFC 822. The file format is 

line-oriented. Lines are separated by line feed characters (ASCII 10). A postmark line consists of 

the four characters From, followed by a space character, followed by the message's envelope 

sender address, followed by white space, and followed by a time stamp. The sender address is 

expected to be an addrspec as defined in appendix D of RFC 822. 

The date is expected to be formatted according to the syntax represented in the augmented 

Backus-Naur formalism used by RFC 822. 

 

3. Which email clients are supported by Stellar MBOX to PST Converter?  

Stellar MBOX to PST Converter supports Thunderbird, Spicebird, Entourage, Pocomail, Eudora, 

AppleMail,  Mulberry, SeaMonkey, Netscape, ClawsMail, OperaMail, MozillaMail, Evolution, and 

Sylpheed files. 

 

4. Can I convert a single mail into PST file? 

You can only convert a complete MBOX file.  

 

5. If the location of MBOX files are not known, can I search for then using Stellar MBOX to 

PST Converter? 

Yes, Find File option of the software lets you search for MBOX files in specified drive of the 

computer. To know how to use this option, please refer Find Files topic of help manual. 

 

6. Can I convert multiple MBOX files simultaneously? 

Yes. 

 



7. I want to save converted mails into an existing PST file. How can I do it?  

Stellar MBOX to PST Converter gives you option to save converted mails into an existing or new 

PST file. For full details, please refer Save Converted Mails topic of this help manual. 

  



Legal Notices 

Copyright 

Stellar MBOX to PST Converter software, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this 

user manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar MBOX to PST Converter® is a registered trademark of Stellar Information Technology Private 

Limited. 

Windows 2000 Server®, Windows 2003 Server®, Windows 2008 Server®, Windows Vista®, Windows 
7®, Windows 8®, Windows 8.1®, Windows 10® are registered trademarks of Microsoft® Corporation Inc. 



All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



License Agreement - Stellar MBOX to PST Converter 

Stellar MBOX to PST Converter 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar MBOX to PST Converter. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar MBOX to PST Converter with which this License is included, you may return the 

complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar MBOX to PST Converter. For purposes of this License, if you have a valid single-user license, you 

have the right to use a single Licensed Copy of Stellar MBOX to PST Converter. If you or your 

organization has a valid multi-user license, then you or your organization has the right to use up to a 

number of Licensed Copies of Stellar MBOX to PST Converter equal to the number of copies indicated in 

the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar MBOX to PST Converter may either be used by a single person or used 

non-simultaneously by multiple people who use the software personally installed on a single workstation. 

This is not a concurrent use license. 

All rights of any kind in Stellar MBOX to PST Converter, which are not expressly granted in this license, 

are entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You shall 

not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works 

based on Stellar MBOX to PST Converter nor permit anyone else to do so. You shall not make access to 

Stellar MBOX to PST Converter available to others in connection with a service bureau, application 

service provider or similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

https://www.stellarinfo.com/


Stellar MBOX to PST Converter and all accompanying software, files, data and materials are distributed 

and provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge 

that good data processing procedure dictates that any program including Stellar MBOX to PST Converter 

must be thoroughly tested with non-critical data before there is any reliance on it and you hereby assume 

the entire risk of all use of the copies of Stellar MBOX to PST Converter covered by this License. This 

disclaimer of warranty constitutes an essential part of this License. In addition, in no event does Stellar 

authorize you or anyone else to use Stellar MBOX to PST Converter in applications or systems where its 

failure to perform can reasonably be expected to result in a significant physical injury or in loss of life. Any 

such use is entirely at your own risk and you would not hold Stellar responsible for any and all claims or 

losses relating to such unauthorized use. 

 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



About Stellar 

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure 

solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed, 

global data recovery, data migration & erasure solutions provider with cost effective solutions available for 

large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and 

has a strong presence across USA, Europe & Asia. 

Product line:  

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

 

Data Erasure 

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently erase 

confidential data beyond the scope of data recovery.  You can perform high speed bulk data erasure & 

generate erasure certificates for audit trail purpose. 

https://www.stellarinfo.com/disk-recovery.htm
https://www.stellarinfo.com/undelete.htm
https://www.stellarinfo.com/mail-recovery.htm
https://www.stellarinfo.com/prevent-dataloss.htm
https://www.stellarinfo.com/prevent-dataloss.php


BitRaser supports 24 International data erasure standards. More Info >> 

 

For more information about us, please visit www.stellarinfo.com. 

https://www.stellarinfo.com/data-erasure/data-eraser-windows.php
https://www.stellarinfo.com/

